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Создание макета 
является первым и важнейшим этапом подготовки публикации к изданию. 

Предполагая, что текст написан, иллюстрации созданы или подобраны, опре-
делены концепция, круг читателей, бюджет издания, можно формировать ма-
кет по следующей классической схеме [2]: 

▼ создать эскиз, примерно отражающий вид документа – тексты, рисунки, 
колонтитулы и др; 

▼ выбрать формат; 

▼ определить ориентацию страницы: книжная (portrait) или альбомная 
(landscape); 

▼ задать размеры полей; 

▼ выбрать элементы дизайна; 

▼ создать или применить готовую модульную сетку. 

При создании эскиза разработчик учитывает характер, бюджет публикации, 
собственный опыт и предпочтения, что весьма слабо формализуемо. Не обла-
дающему в этой области достаточным опытом автору следует использовать 
удачные на его взгляд аналоги и советы специалистов. Ниже будут приведены 
некоторые рекомендации по созданию макета [3]. 

Выбор формата следует заранее обсудить с издателем. В меню Page (Парамет-

ры страницы) любого текстового редактора и dtp-системы есть поле Format со 
списком стандартных форматов. Наиболее распространенные форматы приве-
дены в табл. 1. 

 

Таблица 1.      Наиболее распространенные форматы 

№ Формат Размеры в дюймах Размеры в миллиметрах  

1.  A0 33,146,8 8411189 1189841 

2.  A1 23,433,1 594841 841594 

3.  A2 16,523,4 420594 594420 

4.  A3 11,716,5 297420 420297 

5.  A4 8,311,7 210297  

6.  A5 5,88,3 148210  

7.  A6 4,15,8 105148  
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Размеры полей 

определяются из соображений гармонии  между текстом и размерами полей на 
странице и технологии  получения печатного продукта. Для электронного до-
кумента или страницы, содержащей весь текст целиком, рекомендуются сле-
дующие соотношения между левым, правым, верхним и нижним полями -
3х3х5х8 в относительных единицах (рис.1). 

При выборе размеров полей книжных страниц кроме эстетики следует позабо-
титься о: 

 симметричности текста на смежных страницах при развороте книги; 

 уменьшении внутренних полей при подшивке и внешних полей при об-
резке книжного блока. 

Самым простым способом определения полей является разделение страницы 
на девять  равных частей по горизонтали и вертикали и выборе параметров 
полей [2], как показано на рис. 1. 

 

 

 

Рис. 1. Определение полей для электронного документа и книжной страницы 

 
 

Выбор элементов дизайна 

помогает создать четкое представление о характере издания, расставить акцен-
ты, сконцентрировать или отвлечь внимание читателя по ходу изложения ма-
териала. 
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Основными элементами дизайна публикации [1, 2] являются: 

 буквица; 

 выворотка; 

 пуля (или иной маркер списка); 

 знак акцента; 

 оборка; 

 линейки; 

 выпуск под обрез; 

 рамка; 

 астериск; 

 виньетка; 

 врезка и др. 

Важными структурными элементами страницы являются также заголовки и 
подзаголовки, колонтитулы, колонцифры, форточки, отточия, рубрики, ко-
лонки и др. Особо следует сказать о стрелке, которая является самым сильным 
из элементов дизайна. Не стоит использовать более одной стрелки на странице. 
Особенно странно видеть стрелки «влево» вверху и «вправо» внизу страницы 
или даже две стрелки, указывающие в разные стороны. 

Буквица (инициал) представляет собой первый прописной символ текста, из-
дания или его структурной части увеличенного размера, наборный или рисо-
ванный в виде изображения, часто включающего сложную орнаментально-
декоративную композицию. Бывает спускающаяся вниз на несколько строк 
(опущенная буквица) или располагающаяся в той же строке, что и остальные 
символы слова (поднятая буквица). 

Вывороткой называется текст, напечатанный на контрастном (противополож-
ном) фоне: например белый текст по черному полю. 

Пуля (буллет)- это знак маркера списка: круг, квадрат, треугольник и др. Вхо-
дит в гарнитуру шрифта. 

Знаком акцента считается средство специального оформления элементов для 
придания им особой смысловой нагрузки с помощью специальных указаний, в 
том числе знаки ударения, знаки тильды, вектора и др. 

Оборкой является часть полосы набора, имеющая суженный формат, для за-
верстки сбоку иллюстрации, таблицы, или текста. Настольные издательские 
системы позволяют создать «выемку» с границей произвольной формы, в отли-
чие от текстовых редакторов, допускающих только прямоугольную форму гра-
ницы. 
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Линейки (колонлинейки) представляют собой горизонтальные или верти-
кальные линии, разделяющие элементы макета (колонтитул, колонцифру и 
пр.) или играющие роль украшения. 

Выпуском под обрез называется линия рисунок или текст, выходящий за гра-
ницу полосы после ее обрезки. 

Рамка (контур) – граница объекта для задания формы его обводки. Часто ог-
раничивает растрированный фон, часть текста или иллюстрации. 

 Астериском является знак для обозначения сноски или примечания, часто это 
звездочка (от греческого asteriskos - звездочка). 

Виньетка - это украшение в виде небольшого рисунка на титульном листе, в 
начале или конце раздела. 

Врезкой (втяжкой) называется способ нешрифтового выделения ряда строк в 
тексте путем их набора в меньшем формате, чем основной текст. Врезка может 
набираться другим шрифтом. 

Колонтитул - элемент издания, помещаемый на каждой странице, помогаю-
щий читателю ориентироваться в содержании текста. В качестве колонтитулов 
могут быть использованы названия разделов (или глав) документа и др. С их 
помощью можно оформить нумерацию страниц документа. 

Колонцифра обозначает порядковый номер страницы или столбца и помеща-
ется на верхнем, нижнем или боковом поле страницы. 

Отбивкой считается способ нешрифтового выделения текста путем увеличе-
ния пробелов между отдельными фрагментами текста или элементами полосы 
набора. 

Отточием является пространство между позициями табуляторов, заполненное 
повторяющимися символами (как правило, точками). Отточие часто использу-
ется в оглавлениях книг между названиями разделов и номерами страниц. 

Рубрикой называется структурно-композиционная единица текста издания, 
которая выделена и, как правило, имеет собственный заголовок. 

Словари полиграфических терминов кроме специальных изданий [4] включа-
ют многие сайты, посвященные полиграфии [5,6,8,9]. 

Некоторые рекомендации по созданию макета 

приводятся в соответствии с видением этой проблемы, изложенным в работах 
[2] и [3]. Самые общие рекомендации [2] состоят в  

 накоплении банка аналогов удачных макетов;  

 стремлении к простоте для уменьшения количества ошибок; 
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 использовании в пределах разворота не более трех специальных типо-
графских эффектов. 

Пристального внимания, на мой взгляд, заслуживают рекомендации «Неди-
зайнерской книги о дизайне» Робин Уильямс [3]. Автор формулирует четыре 
основных принципа разработки эскиза макета: приближенность, выравнива-

ние, повтор, контраст. Примеры, иллюстрирующие применение этого прави-
ла, смотрите в Приложении А. 

Приближенность 

говорит о том, что элементы, относящиеся друг к другу должны располагаться 
рядом. Это помогает организовать информацию и уменьшает ненужные пусто-
ты.  

Кроме того, 

o если на странице более 3-5 групп, следует подумать, как можно сгруппи-
ровать эти части, чтобы зрительно слить их в единое целое; 

o не следует «лепить информацию по углам или только в середине»; 

o нужно избегать малейшей путаницы между заголовком, подзаголовком, 
подписями, рисунками и прилегающим к ним материалом. 

Выравнивание 

означает, что ничего на странице не должно размещаться случайно. Каждый 
элемент нужно зрительно связывать с другими элементами. Это придаст стра-
нице аккуратный и изящный внешний вид.  

Следует избегать 

o использования более чем одного вида выравнивания текстовых блоков на 
странице; 

o выравнивания по центру, за исключением случаев, когда сознательно 
формируется «официальная, уравновешенная (часто безликая) презен-
тация». 

Повтор  

наглядных деталей оформления на протяжении всего документа. Повтору 
подлежит цвет, контур, гарнитура шрифта, размеры, линейки и др. Это помо-
гает повысить организованность и логичность текста.  

Важно учитывать, что 

o цель повтора – объединить и добавить документу внешней привлека-
тельности; 
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o повторы можно находить и усиливать или создавать повтор ради повто-
ра; 

o необходимо избегать чрезмерного использования повторяющихся эле-
ментов, которые, начинают раздражать и подавлять, как лишние аксес-
суары. 

Контраст 

используется во избежание одинакового оформления различных по уровню 
(значению, функции) элементов на странице. Если эти элементы – шрифт, 
цвет, размер, толщина штриха, контур, пробелы и др. – не означают одно и то 
же, их следует оформлять по-разному.  

Контраст создается различными способами, противопоставлением 

o крупного шрифта мелкому; 

o изящного шрифта Old Style и жирной рубленой гарнитуры; 

o тонкого штриха (serifа) толстому; 

o горизонтального и вертикального элементов (длинная строка и узкая ко-
лонка); 

o строк и широким и узким интерлиньяжем; 

o маленьких и больших рисунков. 

Не могут контрастировать похожие шрифты, шрифты 12 и 14 кегля, линия под-
черкивания толщиной в один пункт и полпункта, темно-коричневый и черный 
цвет. То, что не совсем похоже нужно сделать абсолютно разным, чтобы не воз-
никло подозрения об ошибке. 

 

Создание и применение модульной сетки будет рассмотрено в ходе описания 
функций InDesign. 

 

Подготовка текста 
является важнейшим этапом в создании публикации и выполняется в соответ-
ствии с правилами набора. Безграмотный набор текста способен свести на нет 
все усилия по созданию качественной публикации. Приведем правила набора 
и переносов, изложенные в работах [2],[6]. 
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Общие правила набора 

 Нормальный размер пробела между словами во время набора равен од-
ному символу. 

 Абзацные отступы должны быть одинаковыми во всем тексте, включая, 
сноски, эпиграфы, врезки и пр. 

 Абзацный отступ основного текста обычно равен 1,5 кегля. 

 Последняя строка абзаца должна быть длиннее абзацного отступа в 1,5-2 
раза. 

 Если набор выполняется без абзацного отступа, то последняя строка 
должна быть неполной. 

 Длина строки должна быть не больше 50-60 символов. 

 На странице должно быть не более 30-40 строк. 

 Нижняя граница текста на предыдущей странице должна быть ниже, 
чем начало текста на следующей странице не менее, чем на 5 строк. 

 Последняя страница главы (если главы начинаются с новой страницы) 
должна выглядеть заполненной хотя бы наполовину. 

Правила переносов 

 Не допускаются переносы, которые искажают смысл слова. 

 Аббревиатуры, которые пишутся большими буквами, типа УНР, КПИ, 
МФО, переносить нельзя. 

 Сокращения, такие, как и т.д., и т.п. и подобные, переносом не разрыва-
ются. 

 Цифры, которые составляют одно число, нельзя разрывать переносом. 
Можно при необходимости разрывать числа, соединенные знаком тире, 
оставляя его в предыдущей строке: 1985 -1990, Х -ХІ ст. 

 Предлоги частицы и междометия (однобуквенные слова), с которых на-
чинается предложение, не должны стоять в конце строки. 

 Инициалы от фамилий не отделяются. 

 Нельзя отделять сокращенные слова от имен и фамилий: 

 проф. Петренко, т. Иванов. 

 Цифру со скобкой или точкой нельзя отделять от следующего слова. 

 Не следует отделять цифры от следующих сокращенных слов и названий 
единиц измерения. 

 Нельзя отделять для переноса знаковые обозначения от следующих или 
предыдущих цифр: 50 %, $ 10, № 25. 
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 Не желательно, чтобы знаки переноса были более, чем в двух смежных 
строках. 

 Между знаком переноса и частью слова не должно быть пробела. 

 Строка не может начинаться знаком переноса. 

 Знаки препинания не переносятся. 

Знаки и цифры 

o Между разделительными знаками (кроме тире) и словом пробел не ста-
вится. 

o Три точки перед словом нельзя отделять пробелом. 

o Тире между цифрами пробелами не отделяется: 20–30. 

o Тире между словами отделяется пробелом.  

o В прямой речи тире справа отделяется пробелом. 

o Дефис не должен отделяться пробелами. 

o Кавычки не отделяются от слов пробелами и набираются тем же шриф-
том, что и текст. 

o Кавычки рекомендуются выполнять «елочками». При наличии в тексте 
одних кавычек внутри других ставится только одна закрывающая кавыч-
ка: «цитата «цитата внутри цитаты». Второй способ оформления: внут-
ренние кавычки набираются „лапками“: «цитата „цитата внутри цита-
ты“».  

o Между знаком номера или параграфа и цифрами пробел обязателен: 
№ 10, § 2. 

o Знаки градусов, процентов, минут, секунд нельзя отделять пробелом от 
цифры: 6%. Сокращения, идущие за знаком градуса, отделяются пробе-
лом: 20° С. Два знака номера или параграфа пишутся вместе: №№, §§. 

o Между цифрами, которые обозначают разные единицы - сотни и тысячи, 
тысячи и миллионы делается пробел: 4 655 210. Обозначение номера и 
дроби нужно набирать без пробела: №125, 3.456. 

o Знаки + и - не отбиваются от цифры: +10. 

o Дроби записываются без пробела: 4/7. 

o Для обозначения десятых и тысячных дробей используется точка: 6.35. 
Встречаются, впрочем и другие рекомендации – использовать запятую. 

o Слово после порядкового номера отделяется пробелом. 

o Индексы набираются 6-м кеглем, независимо от кегля текста, к которому 
он относится.  
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Заголовки 

 В многострочных заголовках каждая строка должна иметь определенный 
смысл. 

 Не рекомендуется заканчивать заголовок служебными частями речи. 

 Переносы в заголовках не допускаются, за исключением многострочных 
заголовков. 

Таблицы 

 набирают шрифтом следующих кеглей: текст 12 - таблицу 8, 10; текст 10 - 
таблицу 6 или 8; текст 8 - таблицу 6 или 8.  

 Строки в заголовках граф должны быть расположены горизонтально и 
выключены по центру.  

 Если ширина заголовка меньше высоты графы заголовка, то строка на-
бирается вертикально.  

 Если таблица занимает две и больше страниц, то графы нумеруются и на 
следующей странице заголовок граф включает только порядковые номе-
ра. 

Выбор шрифтов 
представляет собой одну из центральных задач создания публикации и элек-
тронного документа.  

 Лучше всего о значении шрифта, на мой взгляд, сказал Peter Bebrens: «Шрифт 
– самое красноречивое средство выражения стиля каждой эпохи. Как и архи-
тектура, он дает наиболее характерологический портрет эпохи и является наи-
более суровым свидетельством интеллектуального статуса нации». 

 Рассмотрим основные элементы шрифта, типы шрифтов, его параметры, по-
лиграфические единицы измерения, 

Согласно [7], шрифт – это совокупность графически упорядоченных и различ-
ным образом материализуемых знаков (символов), являющихся средством 
представления текста в издании. Другими словами [1], шрифтом называется ха-
рактер изображения символов текста или набор символов данного рисунка. 
Важными являются также понятия начертание шрифта, фонт и гарнитура 
шрифта. Начертанием шрифта считается один из предусмотренных вариантов 
изображения символов шрифта, характеризующий насыщенность, пропорции 
и наклон при неизменном рисунке шрифта. Фонт – это ассортимент символов 
определенной гарнитуры, начертания и кегля. Гарнитурой называется семейст-
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во фонтов - совокупность знаков конкретного рисунка во всех начертаниях и 
кеглях [7]. 

 

Основными элементами шрифта 

являются высота прописных и строчных букв, соединительный штрих, засечка, 
надбуквенный значок, росчерк, нижний и верхний выносные элементы и др.  

(рис. 2). 

 

 

Рис. 2. Основные элементы шрифта 

 

 

Типы шрифтов 

разделяются на следующие шесть категорий [3]: старый стиль, современный 
шрифт, египетский шрифт с засечками, рубленый шрифт, рукописный 
шрифт, декоративный шрифт. 

Старый стиль 

всегда имеет засечки, засечки строчных букв всегда располагаются под углом. 
Все особенности старого стиля отражены на рисунке 3. Типичными представи-
телями этой группы шрифтов являются Times, Goudy Old Style, Palatino, Gara-
mond. Шрифты Old Style признаются лучшими для набора длинного текста [3]. 
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Рис. 3. Особенности старого стиля на примере Garamond 

 

Современный стиль 

представлен на рис. 4. Эти шрифты не подражают рукописной манере, непри-
годны для набора длинных текстов, эффектны в качестве заголовков.  

К шрифтам этого типа относятся Bodoni, Times Bold, Fenice, Ultra, Walbaum. 

 
 

 

 

Рис. 4. Современный стиль Bod on i  MT  Con d en sed  

 

Египетский шрифт 

появился во времена «египтомании», называется также Slab Serif. Его особенно-
сти видны из рис. 5. Важнейшими представителями этой группы шрифтов яв-
ляются Memphis, Century SchoolBook, Clarendon. 
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Рис. 5. Характерные особенности египетских шрифтов 

на примере Century SchoolBook 

 
 

Египетский шрифт идеально подходит для набора длинных текстов, наиболее 
удобочитаем, часто применяется при наборе детских книг. 

 

Рубленый шрифт 

(sans serif, франц – без засечек) или гротеск, представлен на рис. 6. Часто при-
меняется для создания заголовков и подзаголовков: Arial, Verdana, Folio и др. 
Рубленый шрифт часто именуется с буквой S на конце или со словом Sans: Ro-
manS , Lucida Sans. 

 
 

 

 

Рис. 6. Начертание рубленого шрифта Verdana 
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Рукописные шрифты 

подразделяются на шрифты с соединительными штрихами и без соединитель-
ных штрихов, имитирующие ручной почерк, подобные традиционным калли-
графическим стилям (рис. 7). Никогда не используются в тексте, состоящем из 
одних прописных букв. 
 

Рис. 7. Виды рукописных шрифтов 

 

Декоративный шрифт 

используется для «выражения причуды»[3], неприменим для длинных текстов. 
На рис. 8. представлено несколько видов декоративных шрифтов. 

 

Рис. 8. Рукописные шрифты 
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Когда элементы распределены по странице, между ними устанавливаются раз-
личные взаимоотношения [3] – согласие, конфликт, контраст. 

Согласие 

возникает, когда используется одна группа шрифтов с минимальным разнообра-
зием стиля, размера, толщины и пр. При этом легко соблюдается гармоничный 
официальный, уравновешенный (порой тоскливый) вид страницы. 

Конфликт 

возникает, когда сочетаются шрифты близкие по стилю, размеру, толщине. При 
этом зрительные связи не совсем одинаковы (как при согласии), но и не совсем 
различны (как при контрасте) – следовательно, они находятся в состоянии кон-
фликта. Конфликтов следует избегать. 

Контраст 

появляется при сочетании отдельных шрифтов и элементов текста, отчетливо 
отличающихся друг от друга. Контрасты необходимы, чтобы привлечь внима-
ние. Контраст между шрифтами можно использовать как эстетическое средст-
во, если управлять размером, толщиной, структурой, формой, направлением, 
цветом [3].  

Рекомендации по выбору шрифтов [3], примеры согласия, конфликта и кон-
траста приведены в Приложении Б. 
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Параметры шрифта  

влияют на его внешний вид и объем текста. Метрические характеристики 
шрифта приведены на рис. 9. 

 

 

 

 

Рис. 9. Метрические параметры шрифта 

 

Традиционные полиграфические единицы измерения и система измерений 
ориентированы на управление размерами всех элементов публикации – поло-
сы набора, страницы, полей, шрифта и др. Типометрические единицы измере-
ния имеют давнюю историю и самым красноречивым образом свидетельствуют 
о развитии технологии и техники типографской отрасли производства. Пункт, 
пика, цицеро относятся к абсолютным единицам, круглая, полукруглая и тон-
кая шпация - к относительным. 

Пункт составляет 0,352мм или 1/72дюйма. В пунктах измеряется величина сим-
волов шрифта, интерлиньяж, толщина линий и некоторые другие параметры 
на странице.  

Пика равна 12 пунктам, или 4,236мм, в одном дюйме 6 пик. В пиках выражаются 
ширина и высота колонок и полос.  

Цицеро - это основная единица, принятая в большинстве стран Европы (резуль-
тат неравенства европейского и американского дюймов). Она примерно равна 
пике. 

Как видно из рисунка 9, кегль – это высота строки символов, то есть расстояние 
от верхнего до нижнего выносного элемента плюс поля (оплечики) над и под 
литерой. Высота строки равна наибольшему из кеглей шрифтов, которыми на-
брана эта строка. 

Базовая линия – воображаемая линия, проведенная по основным символам тек-
ста. 
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Интерлиньяж – расстояние между базовыми (основными) линиями смежных 
строк, может задаваться в качестве фиксированной, абсолютно или пропор-
ционально изменяемой величины [7]. 

 Горизонтальные размеры шрифта определяются в шпациях. Круглая, полу-
круглая и тонкая шпации соответственно равны ширине заглавных букв М, N и 
строчной буквы t.  

Круглая шпация равна кеглю, полукруглая шпация равна 0,5 кегля, тонкая 
шпация - 0,25 размера шрифта. Ширина цифры равна полукруглой шпации. 
Соотношения основных единиц измерения [2] приведены в табл. 2. 

 

Таблица 2.  Соотношения основных единиц измерения 

Единицы из-

мерения 

Соотношения 

с единицами типо-

графской системы 

с миллиметром 

при наборе 

Пункт 1/48 квадрата 0,352 

Квадрат 48 пунктов 6,9-17 

Нонпарель 6 пунктов 2,15 

Петит 8 пунктов 2,82 

Корпус 10 пунктов 3,53 

Цицеро 12 пунктов 4,24 

 

Начертание шрифта, 

как упоминалось выше, - один из предусмотренных вариантов изображения 
знаков, который характеризует насыщенность, пропорции и наклон при неиз-
менных стилевых особенностях (рисунке) шрифта. Различают следующие виды 
начертаний [7]: 

 по насыщенности - светлое, полужирное, жирное; 

 по пропорциям (плотности) – нормальное (normal), узкое (condenced), 
сверхузкое, широкое (expanded), сверхширокое; 

 по наклону – прямое, курсивное, наклонное. 

В подавляющем большинстве dtp-систем начертания шрифта можно получить 
с помощью встроенных в нее инструментов. Однако, во избежание неожидан-
ностей при выводе, лучше не деформировать шрифт, а использовать по воз-
можности его готовую реализацию. 
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Емкость шрифта 

измеряется количеством символов в строке и определяет объем занимаемый 
текстом. Шрифты одного и того же кегля могут иметь различную емкость, со-
держать в одной строке разное количество знаков. Емкость лучше всего оце-
нить практически, набрав один и тот же текст в несколько колонок разными 
шрифтами, как показано на рис. 10. Текст, набранный одним кеглем, имеет для 
разных шрифтов свою емкость и насыщенность. 

  

 

Рис. 10. Емкость текста зависит от шрифта 
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Верстка 
 - это формирование полос издания из составных элементов: строк текста, заго-
ловков, формул, таблиц, иллюстраций, колонцифр и др. Главной целью верст-
ки является получение удобочитаемого документа. 

Для описания правил верстки необходимо ввести несколько важных понятий: 
полоса набора, выравнивание (выключка) строк, кернинг, трекинг, вгонка, про-
свет, втяжка и висячая строка.  

Полосой набора называется площадь на странице издания, где размещается 
набор текста и/или иллюстрации. Различают текстовую, иллюстрационную, 
смешанную, начальную, рядовую, концевую полосы издания [7]. 

Выключка строк – процедуры размещения элементов строки от левого до 
правого края (выключка по горизонтали) и размещения строк в пределах от 
верхнего до нижнего края отведенной области (выключка по вертикали). 

Выключка строк по горизонтали включает процедуры размещения элементов 
строк от левого до правого края отведенной области за счет расчета величин 
межсловных пробелов или пробелов, стоящих слева, справа, а также с обеих 
сторон одновременно.  Сюда входит всем хорошо знакомое выравнивание в 
текстовых редакторах: по левому краю, по правому краю, по центру, по шири-
не (блочное). Очень наглядно это понятие иллюстрируется в работе [2], рис. 11. 
Кроме названных типов выключки в dtp-системах реализованы выключки  аб-
заца по ширине с выравниванием последней строки по левому и правому краю 
и др. 

 

ЛЕВОЕ ВЫРАВНИВАНИЕ. Все свободное место 

в строке кроме необходимых пробелов между 

словами, смещается к правому краю. Каждая 

строка начинается со слова (а не с пробела). По-

этому левый кран такого абзаца выглядит ров-

ным и плотным. В то же время правый край вы-

глядит неровным (рваным). 

ПРАВОЕ ВЫРАВНИВАНИЕ. Этот ме-

тод выносит все свободное место на 

левый край, делая его рваным а правый 

- ровным. Метод дает результат, зер-

кальный по отношению к левому вы-

равниванию. 

ЦЕНТРИРОВАНИЕ. Свободное место в строке 

делится поровну между правым и левым краем, а 

в центре помещается «плотная» строка с необхо-

димым количеством пробелов. В результате тако-

го размещения оба края абзаца выглядят неров-

ными, но абзац выглядит симметричным относи-

тельно средней вертикальной линии. 

ПОЛНАЯ ВЫКЛЮЧКА. Свободное 

место между словами распределяется 

поровну так, чтобы и правый и левый 

край абзаца были ровными. Абзац при 

этом выглядит несколько более разре-

женным чем при других способах 

оформления. 
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БЛОЧНАЯ ВЫКЛЮЧКА с левым выравнивани-

ем последней строки. Свободное место между 

словами распределяется поровну так, чтобы и 

правый и левый край абзаца были ровными. Аб-

зац при этом выглядит несколько более разре-

женным чем при других способах оформления. 

БЛОЧНАЯ ВЫКЛЮЧКА с правым 

выравниванием последней строки. 
Свободное место между словами рас-

пределяется поровну так, чтобы  пра-

вый и левый край абзаца были ров-

ными. Абзац здесь также выглядит 

 более разреженным. 

  

Рис. 11. Типы выключек в текстовых редакторах 

 

 

Вертикальная выключка выполняется только в dtp-системах. 

Кернингом называется процедура регулирования межбуквенных пробелов в 
характерных сочетаниях символов.  Тонкая подгонка межбуквенных просветов 
требуется для определенных пар литер (например,  К и А,W и A), параметры 
кернинга задаются в характеристиках шрифта, чтобы не тратить время на экс-
перименты. 

Трекинг – это изменение межбуквенных пробелов для всех знаков во фрагмен-
те текста. Трекинг сильно влияет на окраску текста: при положительных значе-
ниях (разрядке) текст кажется светлее, при отрицательных значениях – темнее. 
Часто используется при вгонке текста. 

Вгонка (выгонка) строк – переформирование строк и/или абзаца после зада-
ния уменьшенных (при вгонке) и увеличенных (при выгонке) величин меж-
словных и/или межбуквенных пробелов. 

Просветом  называется пробельное пространство, находящееся между элемен-
тами букв во внутренней их части, а также расстояние от текста до края фрей-
ма, между фрагментами в линейке, вокруг иллюстрации в тексте. 

Втяжка – это способ нешрифтового выделения ряда строк в тексте путем их 
набора в формате, меньшем, чем текст издания в целом. 

Висячей строкой считается начальная строка абзаца, завершающая полосу, 
или концевая неполная строка абзаца,  начинающая полосу набора. 

Некоторые правила верстки невозможно реализовать средствами текстового 
редактора. Приведем отдельные положения из выборки, сделанной в источни-
ке [6] из справочников по техническому редактированию. 
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Основные правила верстки 

Основной текст 

 В наборе не должно быть коридоров, то есть совмещения пробелов меж-
ду словами по вертикали (или наклонной линии) в трех и более смежных 
строках. 

 После нумерации или буллетов в списках в разных абзацах пробелы 
должны быть одинаковые (фиксированные), чтобы первые буквы этих 
абзацев стояли на одной вертикали. 

 Межбуквенное расстояние (за исключением кернинга пар) должно быть 
одинаковым по всему тексту уменьшение межсловных пробелов в строке 
за счет межбуквенного расстояния не допустимо. Трекингом (кернингом) 
можно пользоваться только в крайних случаях для выгонки или вгонки 
текста, если невозможно это сделать за счет межсловных пробелов. Изме-
ненный пробел может отличаться от нормального не более, чем на 0,02 (у 
некоторых шрифтов это значение может быть другим). 

 Интерлиньяж на одной полосе у строк, набранных одинаковым кеглем, 
должен быть одинаковым. Интерлиньяж должен быть одинаковым у 
обеих страниц разворота. Размер интерлиньяжа зависит от гарнитуры. В 
большинстве случаев – 110–120% от кегля. 

 Количество строк на развороте может отличаться на одну, в крайних 
случаях на две строки. 

 Висячие строки не допускаются. 

 Рядовая полоса должна быть заполнена текстом на 100% по вертикали. 
Последняя строка должна лежать на нижней границе полосы набора. В 
редких случаях допускается неполная полоса, если заголовок (не спуско-
вой) начинается со следующей полосы. 

 Текст должен как минимум на четверть (примерно 10–15 строк основного 
текста) заполнять концевую полосу. При полном заполнении концевой 
полосы текст не должен доходить до низа полосы на 3–4 строки, посколь-
ку это концевая полоса. 

Сноски 

 Нумерация сносок выполняется постранично, если нет отдельного ука-
зания на сплошную нумерацию. 

 Сноски набираются кеглем, который на 1–2 пункта меньше кегля основ-
ного текста. Размер интерлиньяжа должен быть примерно 110–120% от 
кегля. 
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 Индекс сноски  в тексте и в сноске набирается 6-м кеглем, светлым начер-
танием, независимо от кегля и начертания текста, к которому он отно-
сится. 

 Длина линейки составляет обычно 1–1,5 квадрата, хотя может быть про-
извольной. (18–27 мм), толщина – 0,5–0,7 пункта. 

 Расстояние от текста сноски до линейки приблизительно равно половине 
строки (обычно 6 пунктов), от линейки до основного текста -  примерно 
8–10 пунктов. 

 Между сносками должна быть небольшая отбивка (отступ) в 1–2 пункта. 

 Если сноска начинается на одной странице, а заканчивается на другой, 
то разрыв не должен быть на стыке двух абзацев, то есть продолжение 
сноски на второй странице не должно начинаться с нового абзаца или 
висячей строки. На каждой странице должно быть как минимум по 3 
строки этой сноски. Продолжение сноски на второй странице набирает-
ся без абзацного отступа. 

Заголовки 

 Если заголовок, набран прописными буквами, межсловные пробелы долж-
ны быть немного больше, чем обычные. Для заголовков, набранных боль-
шим кеглем (20 пунктов и более), межбуквенное расстояние рекомендуется 
чуть уменьшить. 

 Длина строки заголовка, выключенного по центру, должна быть не более 
ширины полосы набора, уменьшенной на два абзацных отступа. 

 Интерлиньяж заголовка должен составлять примерно 110–120% от кегля. 
Если заголовок набран прописными буквами, то интерлиньяж немного 
увеличивается (120–130% от кегля).  

 Отбивка сверху заголовка должна быть больше, чем снизу.  

 Пространство по вертикали, которое занимает заголовок вместе с отбивка-
ми, должно быть кратным интерлиньяжу.  

 До заголовка должно быть не менее четырех строк основного текста. До-
пускается три строки, последняя из которых должна составлять не менее 
2/3 от ширины полосы набора.  

 Под заголовком на странице должно быть не менее 3 строк основного тек-
ста. При наличии сноски допускается 2 строки под заголовком, при усло-
вии, что первая строка сноски по ширине набрана на полный формат.  

 В пронумерованных заголовках в разрядку набираются только слова «гла-
ва», «раздел», но не номер.  
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Таблицы 

 Верстка сложных таблиц согласовывается с редакторами (они могут изме-
нить структуру таблицы для облегчения работы).  

 Головка («шапка») таблицы набирается на 0,5–1 пункт меньше основного 
текста таблицы светлым начертанием. Ее можно и тем же кеглем, но полу-
жирным начертанием.  

 При наборе больших и  сложных таблиц кегль можно уменьшить до 6 
пунктов. Согласовав с редактором, можно при этом  заменить гарнитуру 
шрифта на рубленную во всех таблицах издания. Кегль головки таблицы 
при этом можно уменьшать не более, чем на 0,5 пункта.  

 Выключка строк таблицы:  
o основного текста – влево;  

o основного текста в достаточно широкой колонке – по ширине;  

o головка таблицы выравнивается по центру;  левую колонка  можно 
выравнивать влево;  

o цифры – по центру, с соблюдением разрядности.  

 В заголовке таблицы слово «таблица» и номер набирается тем же кеглем, что и 

сам заголовок с выключкой вправо;  

 Отбивка  от заголовка до таблицы равняется 6–10 пунктам.  

 Таблица строго привязана к тексту или выносится в приложение. 

 При разрыве таблицы каждая ее часть должна начинаться с верха новой 
полосы.  

 При разрыве таблицы на второй и последующих полосах должно быть на-
брано «Продолжение табл. ...» (отточие – номер таблицы) вверху таблицы, 
курсивом, в правый край.  

 При разрыве таблицы: колонки нумеруются, и на последующих полосах 
головка таблицы не повторяется, а даются только номера; повторяется го-
ловка таблицы, если она не слишком большая (колонки не нумеруются).  

 Примечания к таблице набираются сразу после нее, кеглем меньше основ-
ного на 1–2 пункта, а слово «Примечание(я)» выделяется курсивом или раз-
рядкой.  

 Примечания отбиваются от таблицы на 6–8 пунктов.  

 Отбивки над заголовком таблицы и под таблицей (или под примечаниями 
к ней) 1–1,5 строки.  

 Толщина линеек таблицы составляет 0,5 пункта. Если необходимо выделить 
линейками часть таблицы, то линия утолщается до 1 пункта.  
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Иллюстрации 

 Иллюстрация должна располагаться на той же странице (полосе), где на 
нее есть ссылка или на следующей. В противном случае она помещается 
в приложении.  

 Масштабировать иллюстрацию можно только пропорционально, и в том 
случае,  если это не влечет за собой потери информации и качества.  

 Подпись под иллюстрацией набирается тем же кеглем, что и основной 
текст или на 1 пункт меньше, обычно по центру. Если выключка заголов-
ков в издании влево, то и подписи набираются влево. Вторая и после-
дующие строки набираются со втяжкой и равняются по первой букве на-
звания рисунка.  

 Подпись отбивается от рисунка на 6–8 пунктов.  

 Отбивки над  рисунком и под подписью составляют 1–1,5 строки.  

Формулы 

 Формулы набираются тем же кеглем, что и основной текст, с выключкой 
по центру и отбивками от основного текста в 0,7–1 строку.  

 В группе формул с однотипной левой частью наиболее длинную форму-
лу выключают по центру, а остальные выравнивают по знаку соотноше-
ния.  

 Расстояние между идущими подряд формулами – 4–6 пунктов.  

 Переменные, обозначенные латинскими символами, набираются курси-
вом, цифры прямым начертанием.  

 Сокращения в индексах на русском языке набираются прямым начерта-
нием.  

 Индексы набираются 6-м кеглем.  

 При разбивке одной формулы на несколько строк математические знаки 
(– и т. д.) набираются в конце строки и повторяются в начале следующей.  

 Если формула идет в подбор с текстом, то строка, где она находится, при 
необходимости набирается с увеличенным интерлиньяжем.  

 Номер формулы набирается кеглем основного текста, прямым и выклю-
чается вправо.  

 Пояснения к формуле набираются следующим образом:  

o слово «где» набирается без абзацного отступа;  

o первая переменная набирается в одну строку со словом «где»;  
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o остальные переменные набираются с нового абзаца и со втяжкой, 
равняясь по первой переменной;  

o тире, идущие за переменными, выравниваются по одной верти-
кальной прямой.  

o вторые строки пояснений набираются со втяжкой, равной втяжке 
первой буквы пояснений.  

 Если в пояснениях к формуле слово «где» отсутствует, то переменные 
набираются в левый край, тире, идущие за переменной, выравниваются 
по одной вертикальной прямой, а остальные строки выравниваются по 
первой букве пояснений.  

 Пояснения к формуле также могут набираться в один абзац (в подбор), 
через точку с запятой, без абзацного отступа.  

Колонтитулы и колонцифры 

ө Колонтитул входит в размер полосы набора. Колонцифра, если она не в 
колонтитуле, в полосу набора не входит и размещается на полях.  

ө Колонтитулы и колонцифры набираются не крупнее основного текста 
любым начертанием.  

ө Толщина колонлинейки составляет 0,5–0,7 пунктов.  

ө Колонтитул или колонцифра отбивается от основного текста на 0,5–1 
строки. Расстояние от верха колонтитула до верхней границы основного 
текста должно быть кратно интерлиньяжу основного текста.  

ө Расстояние от колонлинейки до текста колонтитула обычно равно 4–6 
пунктам, чтобы выносные элементы букв на нее не «наползали».  

Оглавление (содержание) 

 Оглавление набирается кеглем, который на 1–2 пункт меньше кегля ос-
новного текста.  

 Соподчинение рубрик показывается выделениями и втяжками.  

 Размер втяжек рекомендуется делать кратным абзацному отступу основ-
ного текста. При большом количестве втяжек – кратным половине абзац-
ного отступа.  

 Нумерация, обозначающая страницы, выключается вправо строкой от-
точий.  

 Нумерация и строка отточий набираются светлым начертанием.  

 Отточия набираются через пробел.  
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Длина строки 

согласно рекомендациям [2], длина строки ограничивается 60 символами. Сни-
жение этой величины до 50 улучшает общее впечатление от страницы. После 
выбора размера строки следует поэкспериментировать с межстрочным интер-
валом, чтобы подстроить его под плотность используемой в наборе гарнитуры. 
Если же выделенное под строку место так велико, что позволяет разместить бо-
лее чем 50-60 символов, то можно  

 выбрать больший кегль и за счет этого остаться в рамках 50-60 символов; 

 выбрать шрифт с более широкими литерами, стремясь не выйти за ре-
комендованную длину строки и заданное количество страниц; 

 перейти к набору в несколько колонок.  

Переносы 

слов необходимо выполнять для более равномерного заполнения полосы набо-
ра символами, особенно  при небольшой ширине колонки,  чтобы не было 
слишком больших промежутков между словами, как это иногда приходится 
наблюдать при блочной выключке средствами текстового процессора или dtp. 

Расстановка переносов  вручную со вставкой дефиса сильно усложняет проце-
дуру внесения последующих изменений, поскольку приходится, вручную уда-
лять «старые» знаки переноса  вставлять новые. 

В современных системах DTP реализованы разнообразные алгоритмы автома-
тической верстки строк. Наличие таких алгоритмов позволяет  более или мене 
успешно бороться с неравномерным заполнением строки при блочной вы-
ключке. Системы выполняют трекинг в длинных словах с строках с особенно 
большими промежутками между словами. Результаты такой верстки с разряд-
кой можно часто наблюдать в газетных статьях [2]. 

Межбуквенные просветы 

являются одним из основных способов улучшения внешнего вида документа. 
Необходимо всегда устанавливать размер межбуквенного просвета при верстке 
с помощью dtp-системы. 

Отрицательный интерлиньяж 

означает, что расстояние между базовыми линиями соседних меньше, чем раз-
мер шрифта в строке. Например, если интерлиньяж составляет 24 пт при раз-
мере шрифта 28 пт.  При верстке обычных текстовых документов используется 
отрицательный интерлиньяж относительно редко. Он безусловно полезен при 
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оформлении различных логограмм, заголовков, колонтитулов, иллюстрации и 
пр.  

Вгонка (выгонка) текста 

часто используется в журналах, бюллетенях новостей, газетах, там, где заранее 
известна площадь, на которой должны расположиться все материалы.  

Количество материала редко соответствует выделенному для него числу стра-
ниц издания. Ниже следующие советы помогут вам несколько «ужать» или 
«растянуть» текст [2]. По убыванию степени предпочтения можно предпринять 
такие шаги:  

 отредактировать текст, удаляя лишние строки. Особое внимание обра-
щайте на строки в конце абзацев, имеющие одно-два слова. Иногда, уда-
лив несколько символов, можно сократить целую строку. 

 использовать трекинг, чтобы вогнать короткие строки, завершающие аб-
зацы. 

 уменьшить интерлиньяж на половину или четверть пункта. Во многих 
случаях это совершенно незаметно, а «выиграть» можно несколько строк. 

 уменьшить на полпункта размер шрифта. Это позволяет внести на поло-
су больше строк и уместить больше текста на каждой строке. 

 немного уменьшить ширину символов (например, установить масштаб 
95%). 

 уменьшить ширину средника между колонками или слегка сократить 
ширину полей. 

Настольная издательская система и текстовый редактор 

направлены на реализацию различных функций при подготовке публикации. 
Современные текстовые редакторы, кроме набора текста, позволяют работать с 
графикой, шаблонами, стилями абзацев, обладают многими возможностями, 
присущими еще недавно только настольным издательским системам. Важней-
шей задачей текстового процессора является набор больших текстовых блоков, 
проверка орфографии, создание стиля абзацев. 

 Эти функции, разумеется, реализуют и настольные издательские системы, но, 
прежде всего, они направлены на создание полиграфического продукта, позво-
ляют свободно манипулировать текстовыми и графическими материалами на 
странице, поддерживают такие специфические функции, как системы управ-
ления цветом, тонкие настройки шрифтов, разные виды кернинга, точное по-
зиционирование элементов публикации и др. 
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Представляется рациональным следующее распределение работ по созданию 
макета между текстовым редактором, и издательской системой. 

В текстовом редакторе осуществляется 

 набор текста; 

 проверка орфографии и грамматики; 

 создание стиля оформления абзацев  и символов для удобства работы с 
текстовым материалом. 

Стилем оформления называется поименованная совокупность параметров 
оформления текстовой информации. 

В настольной издательской системе выполняется 

 кернинг; 

 трекинг; 

 настройка межсимвольных интервалов; 

 выключка; 

 контроль жидких строк; 

 импорт и связывание графики, ее обтекание текстом; 

 наложение изображений и текста; 

 управление цветом; 

 применение шаблонов и некоторые другие операции. 

 



32 

 

Список использованных источников 

 
1. Тайц А.М., Тайц А.А. Adobe

®
 InDesign™

 
СПб.:БХВ – Санкт-Петербург, 2000. -

704с.:ил. ISBN 5-8206-0094-0 

2. http://obzor.com.ua/dtp/kurs/ DeskTop Publishing, или Настольные издательские 

системы. Николай Волков «Курс макетирования и верстки». 

3. Уильямс Робин Недизайнерская книга о дизайне. – СПб.: ИД «ВЕСЬ», 2002. – 

128с. 

4. ОСТ 23.130-97 "Издания. Термины и определения" 

5. http://www.ukr-print.net/contents/page-115.htm -Украина полиграфическая. 

6. http://www.ukr-print.net/article/147.htm Общие правила верстки. Алексей Павлов 

7. СТБ 1583-2005 Технология и оборудование допечптных процессов в полигра-

фии. Термины и определения. Издание официальное. Госстандарт. Минск. 

8. http://www.mamble.nm.ru/dict.htm - Верстка, набор, дизайн. 

9. http://privetprint.ru/new/glossary/ Полиграфия - словарь полиграфических терми-

нов 

10. http://www.rudtp.ru/lib.php?book=112 RU|DTP-настольные издательские системы 

11.  

 

Основные Интернет-ресурсы, посвященные верстке 

http://www.rudtp.ru/lib.php?book=112 RU|DTP-настольные издательские системы 

http://obzor.com.ua/dtp/kurs/ DeskTop Publishing, или Настольные издательские системы 

http://www.ukr-print.net/contents/page-115.htm -Украина полиграфическая. 

http://www.mamble.nm.ru/dict.htm - Верстка, набор, дизайн. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



33 

 

 

 

Интерфейс издательской системы InDesign 

Главное окно программы 

c открытым документом представлено на рис. 12. Важнейшими элементами ок-
на являются: 

 заголовок окна Adobe InDwsign CS2; 

 строка главного меню; 

 панель свойств Control; 

 панель инструментов Tools, знакомая по всем программам Adobe); 

 окно документа с его именем и масштабом отображения 

 вертикальная и горизонтальная линейки, на пересечении которых – пе-
рекрестье начала координат (в левом верхнем углу); 

 строка состояния с окном масштаба и навигатором страниц (внизу окна); 
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Рис. 12. Главное окно программы с открытыми документами 

 

В выбранном пункте меню Window видны открытые палитра свойств  Control, 
палитра управления страницами и шаблонами публикации Pages,  панель ин-
струментов Tools и соответствующие им горячее клавиши. 

 InDesign является многодокументным приложением, что предполагает воз-
можность обмена информацией между окнами - через буфер обмена и с помо-
щью перетаскивания (drag-and-drop). В меню Window видны открытые доку-
менты Untitled-2 и Untitled-3, первый из которых является текущим. 
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Страница (Page), отображаемая в виде белого прямоугольника с тенью, служит 
для размещения элементов макета, которые выводятся на печать. Белое поле 
вокруг страницы – рабочий стол (pasteboard) страницы, на который можно 
временно выкладывать элементы макета. Если элемент полностью принадле-
жит рабочему столу, то он на печать не выводится. Страница также имеет поля 
(margins), показанные розовым цветом и направляющие (guides)  для удобства 
размещения объектов, отображаемые  голубым цветом (рис. 12). 

Размеры страницы, их количество, наличие разворотов (spreads) задаются при 
создании документа. 

Создание документа 

реализуется с помощью меню File>New>Document, в диалоговом окне которо-
го New Document, формируется описание страницы. Важнейшими установка-
ми и параметрами этой формы являются (рис. 13): 

o Document Preset  - умолчания документа, (Custom/DocumPresetE/ 
Default); 

o Number of Pages - число страниц публикации; 

o Facing Pages - установка оборотной печати, подобной страницам рас-
крытой книги, для печати с обеих сторон; 

o Master Text Frame - предназначен для преимущественно текстового ма-
териала при установленных  количестве и размерах страниц, полей и 
при верстке в одну колонку. Этот режим создает на шаблон-странице 
нового документа текстовый фрейм для последующего автоматического 
размещения текста. 
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Рис. 13. Окно создания нового документа 

 

o группа в рамке Page Size  задает размеры страницы и ее ориентацию. 
Ширина и высота страницы выбираются из раскрывающегося списка 
или выставляются вручную в полях Width  и Height. Ориентация может 
быть задана Portrait (книжная) или Landscape (альбомная); 

o параметры Columns (колонки) предназначены для задания числа коло-
нок и размеров Gutter (средника) между ними;  

o Margins (поля) - задают значения верхнего, нижнего, внутреннего и 
внешнего полей страницы; 

o bleed end slug - определяют, когда предполагается обрезать страницу в 
край, не оставляя полей; 
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o кнопка Make all settings the same (сделать все размеры такими же) - с 
пиктограммой в виде звеньев цепи расположена в группе полей и образ-
ки; 

o сохранение поименованных установок (Preset) по клавише Save Preset. 
Имя созданных установок немедленно появится в списке Document 

Preset; 

o  «сброс» установленных параметров и возвращение к документу по 
умолчанию, выбрав из списка Document Preset значение Default; 

o уменьшение количества опций - Fewer Options закроет параметры об-
резки. 

Установки созданного документа в любой момент можно изменить  c помощью 
меню File>Document Setup и Layout>Margin and Columns.  

Объекты InDesign 

представляют собой «контейнеры» для размещения графики и текста, которы-
ми можно легко манипулировать для получения нужного макета. Различают 
три типа объектов (рис. 14): текстовые фреймы, графические фреймы и графиче-
ские объекты. Текст в InDesign размещается только во фреймах.  

Текстовый фрейм создается следующим образом: 

 с помощью инструмента Text (T) панели инструментов Tools рисуется 
прямоугольник (клик левой клавиши мыши задает первый угол, drag-
and-drop и второй клик левой клавиши указывает угол по диагонали), 

возникает текстовый курсор  , клик левой клавиши указывает начало 
текстовой строки во фрейме и превращает курсор в | , текст набирается 
или вставляется из буфера; 

 вставкой из буфера с помощью Edit>Place – при этом текстовый фрейм 
формируется автоматически; 

 вставкой текста или его набором в графическом фрейме с помощью ин-
струмента Text. 

Таким образом, тип фрейма определяется его содержимым. 

Фрейм представляет собой прямоугольник или замкнутую область любой дру-
гой формы, которая получается из стандартных инструментами трансформа-
ции -  из палитры Tools или  меню Object>Transform. Границы фрейма по 
умолчанию отрисовываются сплошной линией синего цвета, а при выделении  
фрейма на них появляются манипуляторы – точки трансформации.  

Для выделения в InDesign используется  инструмент Selection Tool  палитры 
Tools на рис. 14 –  черная стрелка, активен. Все фреймы, кроме первого тексто-
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вого фрейма  на рис. 14  выделены. Красная квадратная рамка со знаком «+» 
возле правого нижнего угла рамки означает, что размеры текстового фрейма не 
позволяют его содержимому (тексту) полностью отображаться на экране. Сле-
дует увеличить размеры фрейма или выбрать в его контекстном меню (рис. 15) 
Fitting>Fit Frame to Content и фрейм увеличится в соответствии с размерами 
текстового блока, который в него помещен. 

 

 
 

Рис. 14. Текстовые и графические фреймы InDesign 

 

Выделенный текстовый фрейм в форме параллелограмма, в отличие от первого 
прямоугольного фрейма, кроме  внешней границы с манипуляторами имеет 
внутреннюю границу Insert Spaсing – отступ от внешней, которая создается в 
диалоговом окне Text Frame Options из контекстного меню или меню Object> 
Text Frame Options (рис. 15). Величина параметра Insert Spacing, установленная 
на рис. 15, соответствует изображению во фрейме-параллелограмме из рис. 14. 
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Эти атрибуты доступны для четырехугольных фреймов, а для фреймов другой 
формы задается один параметр. Кроме отступов  в этом окне можно задать чис-
ло колонок в этом фрейме,  вертикальное выравнивание, отрегулировать по-
ложение первой базовой линии абзаца (Baseline Options), установить игнори-
рование обтекания текстом. 

Текстовые фреймы дают возможность верстать документы любой сложности, 
но разбивать текст на множество текстовых фреймов следует в случае крайней 
необходимости. Такой текст становится непредсказуемым при изменении кегля, 
интерлиньяжа или других «глобальных» изменениях.  

На странице простой верстки в одну колонку должен быть один текстовый 
фрейм. В отдельных фреймах размещаются только сноски, колонцифры, ко-
лонтитулы и врезки. Графика должна быть вложенной  и обтекаемой текстом. 
Центрированные заголовки также не следует размещать вручную в «мини-
фреймах» по центру страницы. Фрейм с заголовком следует установить в ши-
рину страницы и выключить текст по центру. Можно вовсе не создавать от-
дельного фрейма для заголовка, а добиться нужного положения отбивками, ес-
ли заголовок находится на одной странице с текстом. 
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Рис. 15. Контекстное меню текстового фрейма и диалоговое  
окно его параметров Text Frame Options 

 

Графический фрейм предназначен для размещения импортированной рас-
тровой и векторной графики или изображений, созданных средствами встро-
енного редактора InDesign. Графические фреймы создаются инструментами 
Rectangle Frame, Ellipse Frame, Polygon Frame палитры Tools теми же приема-
ми, что и текстовые: все они имеют границу в виде синего прямоугольника с 
диагоналями (рис. 14). При выделении  у графического фрейма, как и у тексто-
вого, по границе включатся манипуляторы.  Импортированное изображение 
видно только в пределах фрейма –  области вне фреймов будут невидимыми 
(маскированными). Если в текстовый фрейм поместить графический объект, 
фрейм станет графическим. 

Графические объекты могут находиться вне или  внутри графических фрей-
мов, поскольку созданы в InDesign или «родственных» векторных приложени-
ях, наподобие Adobe Illustrator. 
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Трансформация фреймов 

в издательской системе заключается в изменении формы и размеров, переме-
щении, повороте и отражении. Трансформация текстовых и графических 
фреймов несколько различаются. 

Перемещение, отражение, масштабирование и поворот текстовых фреймов 
реализуется инструментом Selection Tool,  специальными инструментами па-
литры Tools (рис. 16, 17,18), из меню Object>Transform, Flip на панели свойств и 
др.  

 

 
 

Рис. 16.  Отражения текстового фрейма 
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Инструменты поворота фрейма, включая Rotate палитры Tools, указание цен-
тра вращения (Reference Point) и точное задание угла на панели свойств пред-
ставлены на рис. 17.  Вращать фрейм можно и «вручную» инструментом Free 

Transform. 

 

 

Рис. 17. Вращение текстового фрейма 

 

Панель Tools, кроме того, содержит следующие инструменты трансформации: 
Direct Selection, Scale Tool, Shear, Free Transform.  

Direct Selection деформирует объекты по опорным точкам. Результат такого 
воздействия  в зависимости от их характера объектов представлен на рис. 18. 
Результат работы инструмента . Scale реализует пропорциональное масштаби-
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рование, Shear – непропорциональное масштабирование или наклон относи-
тельно произвольно задаваемого центра. Free Transform позволяет повернуть и 
отмасштабировать одним инструментом.  

Трансформация графических  фреймов отличается от текстовых. Возможно-
стей главным образом тем, что картинка и ее содержащий фрейм могут транс-
формироваться как вместе, так и по отдельности. 
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Рис. 18. Трансформация объектов инструментом Direct Selection 

 

Связывание фреймов осуществляется для того, чтобы обеспечить «перетека-
ние» текста из одно фрейма в другой при их трансформации. Чтобы связать 
фреймы, нужно выделить фрейм с избыточным  текстом, щелкнуть на индика-
торе избыточного текста (при этом возникнет курсор размещения) и указать 
второй, третий и др. связываемые фреймы. Красная линия (в реальности ее 
нет) на рис. 19 показывает, как связаны фреймы: 
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Рис. 19.  Связывание фреймов 

 

Важно помнить, что границы фреймов, так необходимые при верстке, очень 
мешают восприятию готового документа, искажают представление о макете. По 
этой причине следует отключить их отображение из меню View>Hide Frame 

Edges (и включить, когда потребуется,  Show Frame Edges). 
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